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What

is FX Permutator?

FX Permutator is an original Reaper script developed by Tech Audio. It breathes new life into your
existing VST plugin collection. Sort, combine, and curate your plugins into unexpected bliss!

FX Collections

Tools

Options

Log

About

FX
Default preset
Available FX
Filter...
AB Tester (Socalabs) o

AB Tester (x86) (Socalabs)

ADverb2 (Audio Damage, Inc.)

AIR Chorus {AIR Music Technology)

AIR DiffuserDelay (AIR Music Technology]
AIR Enhancer (AIR Music Technology)

AIR Ensemble (AIR Music Technology)
AIR FilterGate (AIR Music Technology)
AIR Flanger (AIR Music Technology)

AIR Fuzz-Wah (AIR Music Technology)

AIR Lo-Fi {AIR Music Technology)

AIR Multi-Chorus {AIR Music Technology)
AIR Non-LinearReverb (AIR Music Technology)
AIR ParametricEQ (AIR Music Technology)
AIR Phaser (AIR Music Technology)

AIR Pumper (AIR Music Technology)

FX pertrack

Random Type Mon-Presets Only

a4

Mumber of tracks Random %
|

4 66

Parallel Chance %
—

23

< Remove

Add All >>

<< Removwe All

Selected FX

8-Bit Shaper (x86) (Xfer Records)

914 (Audio Damage, Inc.)

ADAPTIVERB (Zynaptig)

ADverb (Audio Damage, Inc.)

AIR Compressor (AIR Music Technology)
AIR Distortion (AIR Music Technology)

AIR Dynamic Delay (AIR Music Technology)
AIR FrequencyShifter (AIR Music Technology)
AIR Kill[EQ {AIR Music Technology)

AIR Maximizer (AIR Music Technology)

AIR Multi-Delay [AIR Music Technology)
AIR Reverb (AIR Music Technology]

AIR SaturationFilter (AIR Music Technology)
AIR TubeDrive (AIR Music Technology)

Add and Invert (Socalabs)

Run Clean

How does it work?

FX Permutator creates permutations based on the audio files and plugins you choose from your
arsenal. All you have to do is select an audio track or media item in Reaper, add plugins from the list you
have available, and determine:

How many plugins do | want per chain (FX per track)?

How many chains do | want to generate (Number of tracks)?

How do | want the VST presets and plugin parameters to behave (Random Type)
How much parallel processing do | want per chain (Parallel Chance %)


https://techaud.io/

That'’s it! Click Run, and the script will go to work. It will create up to ten new tracks with unique plugin
chains based on your randomization settings, along with copies of the target media item and regions
for easy listening and decision-making.

Based on your run settings, it will randomize the plugins’ presets, parameters, or both - blasting your
audio files off into different dimensions!

And it doesn't stop there. We've created additional tools so you can save your FX chains, interact with
Reaper’s FX Containers, shuffle the order of the new plugin chains, and further randomize the
parameters and presets, so you can feed your curiosity and discover new surprises!

FX Permutator is a never-ending presentation of the sonic possibilities of your favorite plugins... and
ones that have been long forgotten.

Features

e Create and store collections of plugins
e Apply plugin collections to tracks
o Randomize plugin presets
o Randomize plugin parameters
o Randomize plugin slot location (FX chain order)
o Randomize inclusion and interaction with Reaper’s new FX Containers NEw IN VERSION 1.3
o Randomize chance of adding parallel processing to your chain New iN VERSION 1.3
e Tweak results by continuing to randomize the above settings
e Easily render FX Permutator tracks with automated regions
e Save and share interesting FX chains with your friends

Reaper installation

FX Permutator can be installed like any other Reaper script. To import the script from a repository via
ReaPack, go to Extensions > ReaPack > Import repositories... and paste this FX Permutator repository
link: https://github.com/TeamAudio/reascripts/raw/main/index.xml

Or you can download the script from the Tech Audio website, click Actions > Show action list... > New
action... > Load ReaScript... and select TA_FXPermutator.lua from your file explorer to import the script.

To enable functionality, you will need to first purchase a license on our website. A single license allows
for 3 activations of the script on the devices of your choice.

To activate the script in Reaper, select “Script: TA_FXPermutator.lua” from the list in the Actions
window. If it is your first time running FX Permutator, you will be prompted to enter your activation code,
which requires an internet connection for verification.

From there, you should see FX Permutator’s beautiful interface and the world of possibilities it brings!


https://github.com/TeamAudio/reascripts/raw/main/index.xml
https://techaud.io/
https://techaud.io/?portfolio=fx-permutator

Getting started

First run

To begin, FX Permutator needs an audio file to target. Start by adding a new audio file to your timeline,
or open a project in progress.

Within the FX Permutator interface, you will primarily use the FX Collections and Tools tabs to generate
and modify new plugin chains. Go to the FX Collections tab to see the list of plugins you have available.

FX
EX Collections Collectionds_verb EUEPTE

Tools Available FX Selected FX

reverb
Options
AIR Mon-LinearReverb (AIR Music Technology)
Log AIR Reverb {AIR Music Technology])
AIR SpringReverb (AIR Music Technology)
About BC [CREV-01] Convolution Reverb 0.01 {x86) ([BC.Lab] | Add >
BalanceSPTeufelsbergReverb (BalanceAudioTools)
CloudSeed Algorithmic Reverb (Valdemar Erlingsson) <Remove
10-Reverb (HOFA}
10-Reverb (x86) (HOFA) Add All >>
RX 10 De-reverb (iZotope)
RX 6 De-reverb (iZotope, Inc.) << Remove All
RX 6 De-reverb (x86) (iZotope, Inc.)
RX 7 De-reverb (iZotope, Inc.)
RX 7 De-reverb (x86) (iZotope, Inc.)
RX 9 De-reverb (iZotope)
Ratshack Reverb {Audio Damage, Inc.)

FX per track e
Random Type Non-Presets Only

9
¥ U
Number of tracks Random %

Run Clean

Parallel Chance %

23

Select which plugins you want FX Permutator to randomize (using the Ctrl/Cmd key to select multiple
plugins) and press the Add button to move them to the Selected FX list. You can also filter by keyword
search. In the example above, we're filtering by all plugins that have “reverb” in their name



Add as many as you like (and remove them in a similar fashion). FX Permutator will choose from this
list and add only the number of plugins you determine in the next step.

FX

FX Collections ! Collection05_verb F“.JE'-'-E‘,ila
Tools Available FX Selected FX
reverb AIR Reverb (AIR Music Technology)
Options 10-Reverb (HOFA)
AIR Non-LinearReverb (AIR Music Technology) Ratshack Reverb (Audio Damage, Inc.)
Log AIR SpringReverb (AIR Music Technology)
BC [CREV-01] Convolution Reverb 0.01 (x86) ([BC.Lab] |
About BalanceSPTeufelsbergReverb (BalanceAudioTools) Add >
CloudSeed Algorithmic Reverb (Valdemar Erlingsson)
10-Reverb (x86) (HOFA) <Remove

RX 10 De-reverb (iZotope)

RX 6 De-reverb (iZotope, Inc.)

RX 6 De-reverb (x86) (iZotope, Inc.)
RX 7 De-reverb (iZotope, Inc.) << Remove All
RX 7 De-reverb (x86) (iZotope, Inc.)

RX 9 De-reverb (iZotope)

Add All >>

FX per track
Random Type Mon-Presets Only

®
. o
Number of tracks Random %

Run Clean
4 66
Parallel Chance %

23

When you are happy with your selected FX, determine the following settings:

FX per track - the number of plugins you want to be randomized on each track.
Number of tracks - the number of tracks (and therefore new plugin chains) that you want to be
created in the run.
Random % - the percentage at which FX Permutator will randomize the plugins’ parameters.
Random Type - determines how FX Permutator will randomize plugin parameters:

o All-will randomize key plugin parameters even if it has a preset assigned.

o OFF - means only presets will be randomized on an initial run, but not their parameters.

o Non-Presets Only - means only plugins not assigned a preset will be randomized.

m This feature was added to keep your preset parameters in place and only
randomize plugins without presets

Parallel Chance % - the percentage chance to have parallel routing applied to the plugins in your
chain

o Reaper defaults to serial routing of the plugin output, but now in Reaper 7 you can assign
parallel routing as well.

If you are using FX Permutator for the first time, a reasonable starting point is:



e FXpertrack =4
e Number of tracks = 10
e Randomize % =100
e Random Type = Non-Presets Only
e Parallel Chance % - 20
FX per track
— Random Type Mon-Presets Only
a
Number of tracks Random %
. | . |
10 100
Parallel Chance %
L ]

Once you're set, press the Run button. You will be prompted to select either a Media Item or a Track
(which will affect all items on that track) or cancel the operation. Select one of these options to start
the process.

o Run x

Media ltem Track Cancel

FX Permutator will then begin randomizing your settings and generating new tracks. The run process
may take a little while depending on the number of new chains and the heft of the plugins you’re using.
However, you can see the progress in the Log window even if you don’t see any new tracks pop up
immediately.

~~~Starting FXPermutator~
Track "FXPerm_1"
Plugin "0Ozone 10 (iZotope)", Preset
Tools Plugin "ReaPitch (Cockos)", Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)”, Preset ""
Plugin "Ampeg SVTVR Classic (Plugin Alliance)"”™, Preset ""

FX Collections

Options Track "FxXPerm_2"

Plugin "Ozone 10 (iZotope)", Preset ""
Log Plugin "ReaVerb (Cockos)™, Preset "sweetverbo”

Plugin "Ampeg SVTVR Classic (Plugin Alliance)™, Preset ""
About Plugin "iZotope Nectar 2 (iZotope, Inc.)", Preset ""

Track "FXPerm_3"
Plugin "ReaVerb (Cockos)™, Preset "sweetverbo”
Plugin "ReaPitch (Cockos)”, Preset ""
Plugin "0Ozone 10 (iZotope)"”, Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)”, Preset
Track "FxPerm_4"
Plugin "0Ozone 10 (iZotope)", Preset
Plugin "Reaverb (Cockos)”™, Preset "bad crunch™
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)”, Preset
Plugin "Ampeg SVTVR Classic (Plugin Alliance)™, Preset "
Track "FxXPerm_5"
Plugin "iZotope Nectar 2 (iZotope, Inc.)", Preset ""
Plugin "ReaVerb (Cockos)"”, Preset "Program 1"
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)”™, Preset ""
Plugin "Ampeg SVTVR Classic (Plugin Alliance)"”™, Preset ""
Track "FxPerm_6"

wrr

wrr




And voila! Your new tracks will appear along with new regions so you can quickly find the combinations
you like the most.

One note: the FX will be disabled by default, so be sure to enable them first to hear your interesting new
sounds. Depending on the types of plugins you're using, it may be wise to enable the tracks one at a
time, so you aren’'t met with a wall of noise.
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If you like what you hear, you can save your collections for later use. Please know that when you add a
new plugin to a list, it will be automatically saved to that FX collection list.

FX Collections Default FX collectj EE&%
e Available P New collection...
_ Save collection as... ssic (Plugin Alliance)
Options Design HG-2 (Plugin Alliance)
C1 comp Mono (Waves) c 3
iz C1 comp Mono (x86) (Waves) Rename collection...
C1 comp Stereo (Waves)
About C1 comp Stereo (x86) (Waves) Delete collection iZotope, Inc.)

C1 comp-gate Mono (Waves)
C1 comp-gate Mono (x86) (Waveg
C1 comp-gate Stereo (Waves)

C1 comp-gate Stereo (x86) (Wave
C1 comp-sc Mono (Waves)

The Hills Have Eyes

C1 comp-sc Mono (x86) (Waves) AWQSO m-o
C1 comp-sc Stereo (Waves)

C1 comp-sc Stereo (x86) (Waves) MC razy

C1 gate Mono (Waves)

C1 gate Mono (x86) (Waves)

C1 gate Stereo (Waves) Rea Ra n d om
C1 gate Stereo (x86) (Waves)

Convology XT (Impulse Record) iZOOp

DeEsser Mono (Waves)
DeEsser Mono (x86) (Waves)

Default FX collection

And it doesn’t end therel!

In the Tools window, you can further tweak your new plugin chains and discover your favorite new
concoctions by shuffling the order of the chains, randomizing the plugins, and randomizing the presets.



FX Collections
Options
Log

About

You can also save your FX chains (not to be confused with your FX collections). More about saving your
FX chains can be found in the Save FX Chains section below.

Further runs

After your first run, there’s no doubt you will want to hear another random combination. Simply add or
remove plugins, tweak your randomization settings, and press Run again. The possibilities are endless,
and FX Permutator does the leg work to make these discoveries as easy as the click of a button.

FX Permutator also keeps you organized with a helpful naming convention. It differentiates tracks by
labeling the track count and run count. For example, if you set the Number of tracks to 3 in your first
run, the tracks will be named:

o FXPerm_1 R1
o FXPerm_2R1
o FXPerm_3 R1

The track count is “_1" and the run count is “R1".

If you run FX Permutator again to create three new tracks, they will be named:

o FXPerm_1R2
o FXPerm_2R2
o FXPerm_3R2




With this workflow, FX Permutator takes out the guesswork, so you can focus less on the “work” and
more on the “flow”.

And if you want to start fresh with only your original audio track, just press the Clean button in the
control bar to remove selected tracks or all tracks.

| (x86) (Waves)
0 (Wa
0 (x84
Vave

86) ( Enable Deep Clean
Waveg

x86) (|

| S R EEEN

'es)
(Waves)

You can also Enable Deep Clean to remove all regions and tracks using the “FXPerm” prefix, but use this
with caution. If you have the same prefix throughout your session on non-permutated tracks or regions,
they may also be removed.

Other than that, it's easy to start with a nice, clean slate!

Interface elements

Now that you know how to get started, follow the information below to learn more about how you can
modify your settings and get the most out of FX Permutator.

Control bar

FX per track
|  RandomType Al |

Number of tracks Random %

[:U[:U

In the control bar, you will find the main controls for generating new randomized plugin chains.



Run

This button is the main function of FX Permutator. It lets you start the process by creating new tracks
based on the other settings in the control bar.

When pressed, you can choose to target a single Media Item or select an entire Track.

20 (x86) (Waves)
Wavw

x86)

(Wa

(x86

res)

| (Waves)

In either case, it will create the number of tracks determined by the Number of tracks slidebar.

Clean

4

This button helps you remove tracks that aren’t to your liking. When selected, you are given a few
options:

e Clean Selected - remove the tracks you have selected in your project.
e Clean All - remove all tracks from your most recent run of FX Permutator.
e Enable Deep Clean - removes all regions and tracks using the “FXPerm” prefix.
o Use with caution - if you have the same prefix throughout your session on
non-permutated tracks or regions, they may also be removed.

10



(x80) [Waves)

This option lets you choose the number of plugins you want to be randomized on each track. You can
select up to 10 plugins, but be sure to take into account any plugins you've selected that:

e May prompt for access to licenses (i.e. iLok, Waves, etc.). License prompts will pop up when
these plugins are accessed, so ensure they are already authorized or that your thumb drive is
plugged in.

e Are heavy on RAM usage. This will slow down FX Permutator’s process, but you can still see
updates within the Log window.

Number of tracks

This option allows you to choose the number of tracks (and, therefore, new plugin chains) that you want
to be created in the run.

The tracks’ naming convention is “FXPerm_1 R1” with “_1" indicating the track count and “R1” noting
the run count.

11



Random type

Random Type All

This option lets you choose if FX Permutator will randomize parameters, presets, or both:

e All - will randomize key plugin parameters even if it has a preset assigned.
e OFF - means only presets will be randomized on an initial run, but not their parameters.
e Non-Presets Only - means only plugins not assigned a preset will be randomized.
o This feature was added to keep your preset parameters in place and only randomize
plugins without presets.

Random %

Random %
]
100

This option allows you to determine the percentage at which FX Permutator will randomize the plugins’
presets and parameters.

Parallel Chance %

Parallel Chance %

This option allows you to determine the percentage at which FX Permutator will enable parallel
processing on the plugins in your chain. Reaper introduced parallel routing of plugins in Reaper 7

12



FX collections

LH

FX Collections Default FX collection EUEDIQ
Tools Available FX Selected FX
Options

Ampeg SVTVR Classic (Plugin Alliance)
Log Black Box Analog Design HG-2 (Plugin Alliance)

C1 comp Mono (Waves)
About C1 comp Mono (x86) (Waves)

C1 comp Stereo (Waves)

C1 comp Stereo (x86) (Waves) Add =

C1 comp-gate Mono (Waves) D —
C1 comp-gate Mono (x86) (Waves)

C1 comp-gate Stereo (Waves)

C1 comp-gate Stereo (x86) (Waves) Add All >>
C1 comp-sc Mono (Waves)

C1 comp-sc Mono (x86) (Waves) <<Remove All

C1 comp-sc Stereo (Waves)

C1 comp-sc Stereo (x86) (Waves)
C1 gate Mono (Waves)

C1 gate Mono (x86) (Waves)

C1 gate Stereo (Waves)

C1 gate Stereo (x86) (Waves)
Convology XT (Impulse Record)

This window is the home base for your plugin collections.

In the dropdown menu, you have options to:
e New collection... - create and name a new collection.
e Save collection as... - save the plugins in the Selected FX list.
e Rename collection... - rename your current collection.
e Delete collection - delete your current collection.
e And at the bottom of the menu you will also find a list of your saved collections in the order of
their creation date.

CH
FX Collections Default FX collectg guEgm

New collection...

Tools Awvailable FX
. Save collection as... sic (Plugin Alliance)
Options Pesign HG-2 (Plugin Alliance)
C1 comp Mono (Waves) . 3
Log €1 comp Mono (x86) (Waves) Rename collection...
C1 comp Stereo (Waves)
About C1 comp Stereo (x86) (Waves) Delete collection iZotope, Inc.)

C1 comp-gate Mono (Waves)
C1 comp-gate Mono (x86) (Waved
C1 comp-gate Stereo (Waves)

C1 comp-gate Stereo (x86) (Wave
C1 comp-sc Mono (Waves)

The Hills Have Eyes

C1 comp-sc Mono (x86) (Wawves) AWESO m-o
C1 comp-sc Stereo (Waves)
C1 comp-sc Stereo (x86) (Waves) MC razy

C1 gate Mono (Waves)

C1 gate Mono (x86) (Waves)
C1 gate Stereo (Waves)

C1 gate Stereo (x86) (Waves)
Convology XT (Impulse Record) iZOOp
DeEsser Mono (Waves)
DeEsser Mono (x86) (Waves)

ReaRandom

Default FX collection

13



Available FX list

In this window, you will see the plugins you
have available for FX Permutator to use.
You can press the Add > or < Remove
buttons (or Add All >> or << Remove All) to
add them to the Selected FX list.

You can also use the Filter... text box to
narrow down your results.

Selected FX list

This is the list of plugins from which FX
Permutator will choose to randomize. You
can add as many plugins as you'd like;
however, know that only the number of FX
per track will be used in the permutation.

Available FX

Filter...

Ampeg SVTVR Classic (Plugin Alliance)
Black Box Analog Design HG-2 (Plugin Alliance)
C1 comp Mono (Waves)

C1 comp Mono (x86) (Waves)

C1 comp Stereo (Waves)

C1 comp Stereo (x86) (Waves)

C1 comp-gate Mono (Waves)

C1 comp-gate Mono (x86) (Waves)

C1 comp-gate Stereo (Waves)

C1 comp-gate Stereo (x86) (Waves)

C1 comp-sc Mono (Waves)

C1 comp-sc Mono (x86) (Waves)

C1 comp-sc Stereo (Waves)

C1 comp-sc Stereo (x86) (Waves)

C1 gate Mono (Waves)

C1 gate Mono (x86) (Waves)

C1 gate Stereo (Waves)

C1 gate Stereo (x86) (Waves)
Conveology XT (Impulse Record)

Selected FX

Ampeg SVTVR Classic (Plugin Alliance)

Add >

< Remove

Add All ==

<< Remove All

Black Box Analog Design HG-2 (Plugin Alliance)

Ozone 10 (iZotope)
ReaPitch (Cockos)
ReaVerb (Cockos)

iZotope Nectar 2 (iZotope, Inc.)

Add >

< Remove

Add All =>

<< Remove All

14



Tools

FX Collections

Options

Log

About

This window shows you all the ways you can further tweak and save your new plugin chains.

Save FX chains

This button lets you save the plugin chains created by FX Permutator. You can choose to Save Selected
tracks, Save All tracks, or cancel the operation.

To choose the location for the saved FXChains, go to the Options windows and on the FX Chains tab,
you can designate a path in the FXChain File Path text entry box. If none is set or the path is invalid, it
will use the Reaper default path: AppData\Roaming\REAPER\FXChains.

15



Shuffle FX

This button shuffles the order of the FX chains on the tracks you have selected. You can see this in
action by selecting a few tracks, opening the Mixer in Reaper (or the interfaces of the plugins you've
selected), and pressing Shuffle FX.

Before shuffling: After shuffling:

Randomize Parameters

This button lets you randomize the FX parameters of the tracks you have selected. To see this in action,
select a track, open a plugin from your FX list, and press Randomize FX.

Before: After:

16



stock - Driving Rock Bass 2/4in 2 out \ stock - Driving Rock Bass Param  2/4in2out
ReaComp ReaComp
Envelope Output mix Envelope

Pre-comp: ‘ m P ) : Pre-comp: ‘ m
Attack: ‘ m E‘ Attack: ‘ m 4
Release: ‘ (0 B . Release: ‘ (0

() Auto release ] Classic attack B Auto release Classic attack
2

Output mix

Ratio: ‘ m 2 A5 Ratio: ‘ m
Knee size: ‘ m - | I Knee size: ‘ m
T 42-

o
Detector input: Detector input:

Lowpass m . Lowpass [:D 16152

+9.6 yp Highpass ‘ () Preview filter +41 yg Highpass ‘ m 11046 Prevwewf\\ler

[__J Auto make-up [__J Auto make-up

Threshold RMS size (] Limit output Threshold RMS size m 8819 g (

| Limit output

For some plugins, it's not immediately clear in the Ul if changes were made, so you can also press the
FX Ul button to view the list of parameters and see how they have been affected.

Before: After:

stock - Drivi v+ Param  2/4in 2 out \ v + Param 24in2out U (.
] 284dB : ] -13dB
[T

N

Metering Index

Randomize presets

Randomize Presets

This button allows you to randomize your plugins’ presets. FX Permutator can only see what presets the
Reaper Ul wrapper can expose, which is explained further in the Best practices section below.

17



To see the names of the presets FX Permutator chose to modify in the permutation, open the Log
window. You will see a list of tracks with the plugins and presets they now contain. If the preset is blank

“n

(i.e. Preset
randomize.

FX Collections
Tools

Options

Log

About

~~5tarting FXPermutator~~

Track "FXPerm_1"
Plugin "Ozone 10 (iZotope)", Preset
Plugin "ReaPitch (Cockos)", Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)", Preset
Plugin "Ampeg SVTVR Classic (Plugin Alliance)”, Preset ™"

Track "FXPerm_2"

Plugin "0Ozone 10 (iZotope)", Preset ""

Plugin "ReaVerb (Cockos)™, Preset "sweetverbo”

Plugin "Ampeg SVTVR Classic (Plugin Alliance)”, Preset ""

Plugin "iZotope Nectar 2 (iZotope, Inc.)", Preset ""
Track "FXPerm_3"

Plugin "ReaVerb (Cockos)", Preset "sweetverbo"
Plugin "ReaPitch (Cockos)"”, Preset "
Plugin "0zone 10 (iZotope)", Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)", Preset
Track "FXPerm_4"
Plugin "0Ozone 10 (iZotope)", Preset
Plugin "ReaVerb (Cockos)™, Preset "bad crunch"”
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)”, Preset
Plugin "Ampeg SVTVR Classic (Plugin Alliance)"”, Preset ""
Track "FXPerm_5"

Plugin "iZotope Nectar 2 (iZotope, Inc.)", Preset ""
Plugin "ReaVverb (Cockos)™, Preset "Program 1"
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)", Preset
Plugin "Ampeg SVTVR Classic (Plugin Alliance)”, Preset ™"
Track "FXPerm_6"

), FX Permutator did not choose a preset or the plugin has no preset for FX Permutator to

Just like the other tools, you can press Randomize Presets to affect the tracks that are selected. To see
this in action, open a plugin with a named preset (any Reaper plugin will work), select a track, open the
FX window, and see the preset change when you press Randomize Presets.

Before randomizing preset:

stock - Fader Ride Vocal - aim for 8dB GR v+

ReaComp
Envelope
Pre-comp: ||
Aftack:
Release:
B Auto releass
Ratio: |

Knee size: |

Detector input:

E B Lowpass
211 4B Highpass |

Threshold RMS size

Output (Feedback, Deprecated)

After randomizing preset:

Param 2

Envelope
0.00 Pre-comp: [ | |
4.9 5 Attack:
81 Release

Weird [ Auto release

[ 973 Rstio: |

| | 9.0 ] ] Knee size:

Detectorinput  Main Inputs

Lowpass

H BN
7 4p Highpass

Threshold RMS size

+

b/

Wewrd knee

Param
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FX Container Tools

Reaper 7 introduced FX Containers which give you the ability to have a containerized plugin chain within
your track’s plugin chain. Trippy! These tools function just like their parent level counterparts but only
deal with the plugins that are contained within a Reaper FX Container object. Your option are:

Randomize Container Params - Randomize the parameters for the plugins within a selected FX Container(s)
Randomize Container Presets - Randomize the presets for the plugins within a selected FX Container(s)

Shuffle Container FX - Shuffle the order of the plugins within a selected FX Container(s)

Options

FX Collections Randomization

Tools

Log

About
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In the Options window, you can adjust various settings to assist your workflow.
FX chains

On the FX Chains tab, you can choose how you want to save your FXChains and how they behave.

FXChain Prefix - lets you add a prefix to your saved RfxChains. These are saved in the folder dictated by
the FXChain File Path. The naming convention is:

“[Prefix] [Track X] - [Name of Track].RfxChain”

e For example, if you set the prefix to “Favorite” and have a track named “FXPerm_1 R2”, the result
will be:

“Favorite Track 1 - FXPerm_1 R1.RfxChain”

FXChain File Path - lets you set the location for the saved FXChains. If left blank or if the path is invalid,
it will use Reaper’s default path: AppData\Roaming\REAPER\FXChains.

Enable FX Chains on run - when enabled, your FX will not be bypassed by default.

e WARNING: While this seems like a good idea, it may not be the best workflow for all plugins,
especially ones that activate upon playing regardless if the playhead is on a media item (such as
Vinyl by iZotope) or plugins that are very loud, such as compression or distortion plugins.

Spacing

FX Collections FX Chains Spacing Randomization
Tools ltem Spacing (seconds)

Options 1

Log Region Tail (seconds)

About 1

This window focuses on the length of your regions.

Item Spacing - lets you change how many seconds in between the tail of the previous region and the
start of a new one.
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Region Tail - lets you change the latter part of a region, which is determined by how many seconds after
a media item ends. This helps with chains that have longer tails.

Randomization

' FX Chains v Spacing

This window lets you determine your randomization settings.

Restricted FX Parameter Names - lets you enter names of specific plugin parameters you do not wish
to randomize. This can be useful for restricting and tuning exactly what you want to randomize. These
names must be separated by a comma, e.g. Mod,Volume,Gain.

FX Containers

' FX Chains ' Spacing ' Randomization

This window lets you determine the inclusion and behaviors of Reaper’'s FX Containers within FX
Permutator. If you're unfamiliar with FX containers, you can learn more about them here. Important to
note that Reaper treats an FX Container as a single plugin. However it’s a special folder that can contain
many plugins.
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Click the checkbox: “Enable FX Container creation” to allow the inclusion of FX Containers in your main
chain

Then adjust the following settings before you start your run.

FX Container creation chance % - The percentage chance that the FX in your chains will become
containers. 100% will yield all containers in your chains, no single plugins.

FX per container - Behaves just like FX Per Track in the main control bar Ul but determines how many
plugins per container created.

Enable random FX count per container - Enabling this checkbox allows you to randomize the number of
plugins per container. The value you have set in FX per container will act as the max value. 1 being the
min value

FX Container Random % - Behaves just like Random % in the main control bar Ul but determines the
randomization of plugin parameters within FX Containers only

FX Container Collection - a drop down that features your saved FX Collections. You can specify a
specific collection to be used just for the FX Containers. Default is [Currently Selected FX]

Random Type - Same functionality as the Random Type drop down in the main control bar Ul.

Container FX parallel chance % - Behaves just like Parallel Chance % from the in main control bar Ul but
limited to the plugins in the Container...you get the idea by now.
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Log

- ~~Starting FXPermutator~
FX Collect = "
oliections Track "FxPerm_1
Plugin "0Ozone 10 (iZotope)"”, Preset

Tools Plugin "ReaPitch (Cockos)", Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)"”, Preset ""
EEiTnE Plugin "Ampeg SVTVR Classic (Plugin Alliance)", Preset ™"

Track "FXPerm_2"
Plugin "Ozone 10 (iZotope)", Preset

Log Plugin "ReaVerb (Cockos)", Preset "sweetverbo"
Plugin "Ampeg SVTVR Classic (Plugin Alliance)”™, Preset ""
About Plugin "iZotope Nectar 2 (iZotope, Inc.)", Preset ""

Track "FXPerm_3"
Plugin "Reaverb (Cockos)™, Preset "sweetverbo™
Plugin "ReaPitch (Cockos)", Preset ""
Plugin "Ozone 10 (iZotope)", Preset ""
Plugin "Black Box Analog Design HG-2 (Plugin Alliance)"”, Preset

wrr

The Log window provides useful information about what FX Permutator is doing. It will list each track
name (e.g. “FXPerm_1") and the plugins on that track as well as the names of the presets being used. If
you only see a “ next to Preset, that means that no preset was used in that run.

About

On the About window, you will find information about the version of FX Permutator you are using as well
as the year it was developed, copyright information, and a link to the Team Audio website.

Best practices

Run asa separate process

FX Permutator is powerful but can become unstable due to plugin stability and behaviors. Odds are, if

your system already has some problematic plugins, you will likely see some crashes when using them

with FX Permutator. We recommend switching over problematic plugins to run as a Dedicated process
in Reaper.

To do this, press the FX button, right-click the problematic plugin, select Run as, and select Dedicated
process. More information about dedicated processes can be found on the Reaper blog.
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https://teamaud.io/
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Clear fiter

Add to Track 1

all plugins, le

Preset library repository

To get the best out of FX Permutator, you will need to make sure Reaper is supplied with readable

plugin presets. A lot of plugins do not natively provide access to their presets, so we have created a
repository of presets you can load in Reaper.

FX Permutator preset repo link: https://github.com/TeamAudio/fx-presets
To import a Reaper preset library file, go to your track’s FX chain, press the “+” button near the preset

dropdown menu, select Import preset library (.rpl)..., and select the .rpl for the plugins
FX: Track 2 "FXPerm_1 R2" [BYPASSED] ES

-n

X Edit Options

Mo pre wl|+
Re:

RRIEE

Import preset library (rpl)...

Wet: Dry:  Impuls se E Export preset library

Import VST patch/bank file (fxp/.fxb)
Export V5T patch/bank file

Send all keyboard input te plug-in
Link te MIDI program change
Compatibility settings

When adding these preset libraries in Reaper, please make sure you verify the plugin type (VST, VST2,
VSTS3, etc.) and download the correct version.
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VST versions

Each plugin type will have different preset library files you will need to import. If presets are available,
they will be shown in the drop-down list of presets.

FX{ Edit Options

Be aware that the VST/VST2/VST3 versions may have different presets. For example, a VST may have
no preset while the VST3 version does. This may affect what Random Type you want to select to
randomize the parameters.

The imported preset .rpl for a VST/VST2/VST3 will depend on who authored it, and they may react
differently to randomization as well. For instance, some VST3s contain Midi CC information, meaning
they contain 129 additional tracks. Though Midi CC data is always filtered and never randomized, this
can cause a VST3 to delay during randomization, while the VST version may respond quickly.

Additionally, there can be varying delays across any VST depending on the number of parameters the
VST has and the number of presets that you have available to randomize.

Troubleshooting

If you’re installing Reaper and you’re importing your configuration file from a previous Reaper setup,
you may need to delete or rename a few .ini files depending on what you've added to your exported
configuration file.

If you open up FX Perm on a new Reaper install, or on a new machine, and the FX Perm Ul still lists all
of your plugins from your previous workspace, you'll want to locate and delete/rename

reaper-vstplugins.ini and reaper-vstplugins64.ini

Once you delete these files and open Reaper, these files be rebuilt with your current plugin index. We
recommend making a backup of your config directory before deleting any files.

For additional help please don't hesitate to contact us at support@techaud.io.
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Thank you

We want to keep making useful tools and fun toys. If you like FX Permutator, please help us spread the
word. Tell a friend for us and we will love you forever. Well, we already do love you forever, but we'll love
you even more. Thank you so much.

Glossary

e FX chain = the chain of plugins stored on a track

e FX collection = the list of plugins selected for FX Permutator to access on a run
e VST = Virtual Instrument

e .rpl = Reaper Preset Library
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